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Introduction and Prerequisites 
This manual describes how to install deSide as either an upgrade to a previous version of deSide, or 

as a clean installation. 

The tasks involved in this deployment include such things as installation and configuration of a 

database and configuration of proxy settings. 

To successfully install or upgrade deSide you will need: 

 Intermediate IT skills. 

 Basic knowledge of Microsoft SQL Server. 

 Your GR-ID and password. 

 Access to a user account with administrative permissions. 

 Knowledge of any proxy settings or other internet security processes in place in your 

organization. 

 Access to the internet. 

For each of the global-roam products that you install or upgrade, you will need to go through the 

following steps: 

1. Installation of the software 

2. Configuration of Proxy settings  

3. Activation of your software license  

4. Configuring a connection to the database  

5. Install databases and tables 
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The deSide Suite 
The deSide Suite consists of 4 components. The deSide Updater, the deSide Database, the deSide 

Client and the NEM Ticker. 

 

The deSide Updater is responsible for obtaining NEM (National Electricity Market) data from global-

roam using the Internet. It stores this data in the deSide Database. 

The deSide Database is a set of two databases installed into an SQL Server instance. This is the 

primary storage location for all NEM data, as well as some of the end user settings for the deSide 

Client. 

The deSide Client is a windows desktop application that displays NEM data, as read from the deSide 

Database.  

The NEM Ticker is a small windows desktop application that also displays NEM data as read from the 

deSide Database. 
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How to read this document 
Depending on your needs, there are several different paths through the install process. This 

document is structured to guide you through the path that is most appropriate to you.  Throughout 

the document there are questions you can answer and directions to the relevant sections dependent 

on your answers.   

If you do not know the answer to a question posed, consult your IT department. If you ARE your IT 

department, and you don’t know the answer to a question posed, contact global-roam. 

The following flow diagram outlines the general process for installing or upgrading to the latest 

version of the deSide Suite. 

First Time Upgrading

Are you upgrading or installing for the first time?

Install SQL Server

You trialing?
Yes

No

Can you access 

webdb.deside.info over 

port 1433?

YesNo

Install the deSide 

Updater

Install the NEM 

Ticker

Install the deSide 
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Install the Reaper

You’re done!

Do you have a supported version of SQL Server?
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Do you use your SQL Server for anything 

else?
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state of the deSide 

Updater
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Do you need to install additional copies 
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No
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Supported Platforms 

Operating Systems 
deSide is officially supported on the following platforms: 

 Windows XP 

 Windows Vista (32 bit) 

 Windows Vista (64 bit) 

 Windows 7 (32 bit) 

 Windows 7 (64 bit) 

deSide may work on other Windows platforms – please let us know how you get on... 

SQL Server 
deSide requires an installation of Microsoft SQL Server. The following versions are officially 

supported: 

 Microsoft SQL Server 2000 

 Microsoft SQL Server 2005 

 Microsoft SQL Server 2008 

 Microsoft SQL Server 2008 R2 

 Microsoft SQL Server 2008 R2 Express 

deSide may work on other versions of SQL Server – again, please let us know how you get on... 

.NET Framework 
The deSide Client requires the .NET Framework 2.0 SP2. If you do not have this installed, and you 

install using the .EXE file, it will install it for you. This may take also some time. 

If you use the .MSI file to install, you must have the .NET Framework 2.0 SP2 installed beforehand, or 

the .MSI will simply fail with an error message. 

The deSide Updater requires the .NET Framework 4.0 Full Profile. If you do not have this installed, 

and you install using the .EXE file, it will install it for you. This may take some time. 

If you use the .MSI file to install, you must have the .NET Framework 4.0 Full Profile installed 

beforehand, or the .MSI will simply fail with an error message. 

File System Access 
The deSide Client and Updater may create and write to a number of folders under the following 

locations: 

 For Windows XP:  
Documents and Settings/All Users/Application Data/global-roam 

  

 For Vista and Windows 7:  
ProgramData/global-roam 
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Hardware Requirements 
The deSide Client requires the following hardware: 

 Processor : Pentium III-compatible processor or faster; minimum 1.0 GHz, recommended 2.0 

GHz or faster. 

 Disk Space: 182 MB free disk space. This assumes that the .NET prerequisites are already 

installed on the target machine. 

 Memory: 1 GB RAM or more (recommended 4 GB) 

The deSide Updater requires the following hardware: 

 Processor : Pentium III-compatible processor or faster; minimum 1.0 GHz, recommended 2.0 

GHz or faster. 

 Disk Space: 275 MB free disk space. This assumes that the .NET prerequisites are already 

installed on the target machine. 

 Memory: 1 GB RAM or more (recommended 4 GB) 

Network Requirements 
The deSide Client and deSide Updater require access to the Internet using HTTP and XML over HTTP 

(SOAP).  You will need to make sure that your proxy is configured to permit this access.  The URLs 

that deSide requires access to are 

 www.global-roam.com 

 global-roam.webcentral.com.au 

 www.dataserver1.com 

 www.dataserver2.com 

 www.dataserver3.com 

For trial versions of deSide you may be able to access our web database if you have access to 

webdb.deside.info over port 1433. 

NOTE: The deSide Updater service is installed by default under the Local Service account. If your 

proxy requires authentication, then this account will not work. To resolve this, run the deSide 

Updater Service under a domain account that does have the ability to authenticate to the proxy. 

Contacting Global-Roam 
If you experience difficulties in installing or upgrading deSide, please feel free to contact us at:  

e-mail: support@global-roam.com 

phone: +61 7 3368 4064 

  

http://www.global-roam.com/
http://global-roam.webcentral.com.au/
http://www.dataserver1.com/
http://www.dataserver2.com/
http://www.dataserver3.com/
mailto:support@global-roam.com
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Start Here 
QUESTION:  Are you upgrading an existing installation of the deSide Suite? 

 If you currently have deSide, and the version of the Client or Updater is less than the version 

available on the deSide Portal (www.deside.info), then you have an existing installation, and 

you’ll need to upgrade it. 

If “Yes” (you are upgrading), go to the question at the start of the section Upgrading an Existing 

Installation on page 45. 

If “No”, continue on to the next section. 
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Installing For the First Time 
QUESTION:  Are you installing a trial of deSide? 

If “Yes” (you are going to trial deSide), go to the section Installing a Trial Version, on page 12.  

If “No” (you are installing a full, commercial license) go to the section Installing a Licensed Version on 

page 11. 
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Installing a Licensed Version 
QUESTION:  Do you already have an SQL Server instance that you are able to install the deSide 

Database on? (see Supported Platforms on page 7 for a list of the SQL Server versions that deSide can 

use) 

If “Yes”, skip down to the section Installing the deSide Updater on page 15.  

If “No”, go to the section Installing an Instance of SQL Server on page 13. 
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Installing a Trial Version 
QUESTION:  Do you have internet access to the URL webdb.deside.info over port 1433?  

Installation of your deSide trial will be simplest if the answer to this question is “Yes”.  If you have 

access to this URL then you can make use of a database hosted by global-roam for trial purposes, 

and you will only need to install the deSide Client. You will not have to install or configure a local 

database or the deSide Updater.   Please check with your local system administrator and obtain 

access to this URL if possible. 

If “Yes”, you do have access to the required URL, then go to the section Installing the deSide Client 

on page 25. 

If “No”, go to the section Installing an Instance of SQL Server on page 13. 

  



13 
 

 

Installing an Instance of SQL Server 
You’re about to install the component highlighted in green in the following diagram. 

 

We recommend that you install SQL Server 2008 R2 Express. SQL Server 2008 R2 Express is a free 

database server provided by Microsoft.  

Download SQL Server 2008 R2 Express from http://www.microsoft.com/express/Database/.  

 Make sure you download version appropriate for your operating system (32 bit for 32 bit 

operating systems, 62 bit for 64 bit operating systems). 

 Also, make sure that you download both the database and the management tools. 

Run the installer for SQL Server Express.  You may be prompted to install .NET Framework v3.5 as a 

prerequisite. 

 These instructions assume you use the default name for the database instance which is 

“SQLEXPRESS”. 

 During the install of SQL Server Express, you will be prompted an authentication mode.  We 

recommend that you select "SQL Authentication Mode".  You will also be prompted to create an 

account for connecting to the database. We recommend that you create an account specifically 

for deSide to access the database.  This account must have read/write access to the database.   

Run the installer for the SQL Server Management Tools. 

Having run the installers, run the "SQL Server Configuration Manager" to check that the install 

worked. You can find the SQL Server Configuration Manager through the Windows Start menu under 

[Programs - Microsoft SQL Server 2008 R2 - Configuration Tools]. 

http://www.microsoft.com/express/Database/
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 Use the SQL Server Configuration Manager to make the SQL Server instance accessible over your 

network. To do this, select [SQL Server Network Configuration -> Protocols for SQLEXPRESS] 

from the panel on the left hand side of the screen, and enable at least TCP/IP. 

 NOTE: To access your SQL Server instance over the network you may also need to open up TCP 

ports appropriately in your firewall to the host machine. The default SQL Server port is 1433. 

You can now continue on to the next section - Installing the deSide Updater. 
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Installing the deSide Updater 
You are about to install the component highlighted in green in the following diagram. 

 

The deSide Updater connects to the SQL Server and so you will need to have the details for this 

connection. These details are: 

 The address for this SQL Server instance (machine name and SQL server instance name). 

 The account details for connection to the database.  Make sure you have an account with 

write permissions, because you will be using the deSide Updater to create the necessary 

database and tables. The deSide Updater also requires write permissions to the database in 

general, as it will be constantly writing to the database as part of its normal operation. 

The deSide Updater should be installed on a stable machine, one with high availability (on all the 

time, does not regularly get restarted). Desktops and laptops are not usually acceptable for the 

deSide Updater (there’s nothing stopping you from installing the deSide Updater on them, but do it 

at your own peril).  
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Installation 

Download the install file for the deSide Updater from the download section of the deSide web site 

(go to http://www.deside.info  and follow the links to the Download page). 

If you are using Windows XP or below, simply double click the install file, and then follow the 

prompts until it has completed.  

If you are using Windows Vista or above, right-click the install file and choose the “Run As 

Administrator” option, then follow the prompts until the installation has completed. 

If you do not already have the .NET Framework 4.0 installed, the installer will install it. This may take 

some time. 

Once the installation has completed, you should be able to see an icon for the deSide Updater on 

your desktop. Additionally, there will be Windows Service installed called “deSide UpdateEngine”. 

The Windows Service will be installed with default login details. Following the install, confirm that 

these logon details are set to a user who has access to the internet and to the SQL Server instance 

that you have chosen (the deSide Updater requires access to the internet and to its database). 

  

http://www.deside.info/
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Configuration 

Double-click on the deSide Update Service shortcut on the desktop. This is the deSide Updater 

interface when it’s not doing anything: 

 

Go to [File -> Application -> Start]. 
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Proxy Setup 

The deSide Updater requires access to the following websites using HTTP and XML over HTTP 

(SOAP): 

 www.global-roam.com 

 global-roam.webcentral.com.au 

 www.dataserver1.com 

 www.dataserver2.com 

 www.dataserver3.com  

If the deSide Updater has experienced a problem with connecting to any of the websites above, it 

will display the Proxy Settings screen. It looks like this: 

 

If you do not use a proxy to access the internet, simply click OK. 

If you do use a proxy, then we suggest that you maintain your proxy information in your system 

settings. If you make sure the [Use System Settings] option is checked on the Proxy Settings screen, 

then your system settings should automatically be detected and used in the deSide Updater. 

If you have difficulties with the deSide Updater with regards to internet access, you may need to 

manually specify your proxy settings and credentials. This can be done on the Proxy Settings screen. 

NOTE: The Proxy Settings screen is also available from inside the application at [Tools -> Internet 

Settings]. This option is only available when the deSide Updater is running as an Application, this 

option will not be available if the deSide Updater is running as a Service. 

http://www.global-roam.com/
http://global-roam.webcentral.com.au/
http://www.dataserver1.com/
http://www.dataserver2.com/
http://www.dataserver3.com/
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NOTE: The deSide Updater service is installed by default under the Local Service account. If your 

proxy requires authentication, then this account will not work. To resolve this, run the deSide 

Updater Service under a domain account that does have the ability to authenticate to the proxy. 

License Activation  

On first startup, the deSide Updater will display a screen saying that “This machine does not have a 

license for deSide”. 

Simply follow the instructions on the screen to configure a license for the deSide Updater (it mostly 

involves entering information/selecting options and clicking next). 

If you are trialing, on Step 3 of the licensing process (Select License), you should choose Option 2 

(Request and Activate a new Trial), which will get you a brand new trial license. 

If you do not have any licenses to select on Step 3, and you believe that you should have a full 

commercial license, then you will need to go to http://www.global-roam.com/secure to manage 

your licenses before you can go any further. After you login to the website, click on My Licenses 

(top-right corner). On this page you can manage your licenses. If you didn’t have a license available 

in Step 3, you may need to deactivate one of your existing licenses to free it up for use. 

You cannot start the deSide Updater without a valid license. 

  

http://www.global-roam.com/secure
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Database Setup 

On first startup, the deSide Updater will display a screen called “Data Source Setup”. This screen is 

the database settings screen. It will allow you to point the deSide Updater at the database that it 

needs to update. On first startup, it will look something like this: 

 

Configuring the AEMO Database Connection 

This database is where the deSide Updater stores all of the data that it downloads. To configure the 

AEMO Database Connection, from the database settings screen 

 Select the AEMO Database Connection 

 Click the Configure Selected button. 

On the next screen, select AEMO_MSSQL in the drop-down box at the top, and click the New button. 
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Fill the next screen in with information about how to connect to an SQL Server where you want to 

install the deSide Database.  

 

Note:  

If you cannot find your SQL Server in the server drop down box, you can simply type in the name of 

the machine that it is on, followed by a “\” character, followed by the instance name. e.g. 

MACHINE_NAME\INSTANCE_NAME. 

Once you have filled out the name, server and authentication, use the ”Database on Server” drop 

down box to select the “<Install New Database>” option.  

Click on the “Install Database” button. 

Enter the name for the deSide Database. If the default name is fine, simply click OK. If you enter 

something different write it down for later. 

Enter the confirmation word at the bottom of the next screen and click “Confirm” to execute the 

installation script. If you wish to check the script, or run it in some other way, feel free to extract it 

from the text box (or save it using the Save button). 

Once the script has finished executing, the database you just installed will be selected in the 

“Database on Server” drop down box. Click Test Connection to verify that everything is okay. If it is, 

click OK. 

Keep clicking OK until you get back to the main database settings screen. It should now look like this: 
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Note that the AEMO Database Connection says “Valid” next to it (this means it’s all set up and ready 

to go). 

Click Done. 

Note:  

If you need to change your database settings after setting them up initially, stop the deSide Updater, 

go to “C:\Documents and Settings\All Users\Application Data\global-roam\deSide Data Updater\” 

(on Windows Vista and above, C:\ProgramData\global-roam\deSide Data Updater\”) and delete the 

file “deSideDataUpdater_DataAccessManager.settings.xml”. Restart the deSide Updater in 

application mode (File -> Application -> Start) and it will prompt you for database settings again.  
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Done with the deSide Updater 

At this point your updater should be showing a list of file types, and the last times that a file of that 

type was downloaded and processed. 

Please leave the deSide Updater to run until it has finished populating the database for the first 

time. This may take an hour or so, depending on the speed of your machine.  

Once the population has run for about an hour, you can safely go to File -> Application -> Stop, and 

then go to File -> Service -> Start in order to set the deSide Updater to run completely 

autonomously. You can safely close the Updater Interface at this point, and it will continue to work 

in the background as a Windows Service. 

If you cannot see at least some activity, or if you do not have any files appearing at all, or you see red 

errors, something is wrong, and the deSide Updater is probably not working. If this is the case, 

please contact global-roam. 

Go to the section Installing the Database Maintenance Scripts (the Reaper Script) on page 24. 

  



24 
 

 

Installing the Database Maintenance Scripts (the Reaper Script) 
The reaper is a small SQL Script set to run automatically at regular intervals, to keep the size of the 

deSide Database relatively small.  This section provides instructions for setting up a Windows 

Scheduled task to run this Reaper Script at regular intervals.  You will need to download the script 

and place it in a well known folder that is accessible to the Scheduled Task. 

Download the Reaper Script for the deSide Updater from the download section of the deSide web 

site (go to http://www.deside.info  and follow the links to the Download page). 

Set up a new Windows Scheduled Task – if you need to, please consult the Windows Help system to 

find out how to establish a Scheduled Task on your operating system. 

The Scheduled Task should be set up to run a command line as follows: 

sqlcmd.exe -S [SERVER_NAME] -U [USERNAME] -P [PASSWORD] -i [PATH TO SCRIPT] 

where the following are the arguments: 

 SERVER_NAME is the fully qualified address of the SQL Server that the deSide Database is 

installed on (MACHINENAME\INSTANCENAME) 

 

 USERNAME is a user account in the specified SQL Server with delete permissions on the deSide 

Database 

 

 PASSWORD is the SQL Server password for the above USERNAME 

 

 PATH_TO_SCRIPT is the full path to the Reaper script file that you downloaded above 

Note that sqlcmd.exe is typically located in  

C:\Program Files\Microsoft SQL Server\[VERSION]\Tools\Binn. 

Pick the latest version if there are multiple. 

Schedule this task to occur every day (once every 24 hours) at midnight. 

Note: 

If you followed the steps above you had the option of changing the default database name, which is 

“NEMMCO”.  The Reaper Script relies on the fact that the database name is correct in the script. If 

your deSide database is NOT named “NEMMCO” you will need to slightly change the downloaded 

script file.  

The section you need to modify is at the top of the file. It looks like this: 

USE NEMMCO 

GO 

Change the word “NEMMCO” to *YOUR_DATABASE_NAME+ (make sure you include the square 

braces), and save the script.  

http://www.deside.info/
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Installing the deSide Client 
You’re about to install the component highlighted in green in the following diagram. 

 

 

Installation 

Download the deSide Client from the download section of the deSide web site (go to 

http://www.deside.info  and follow the links to the Download page).  

If you are using Windows XP or below, simply double click the install file, and then follow the 

prompts until it has completed.  

If you are using Windows Vista or above, right-click the install file and choose the “Run As 

Administrator” option, then follow the prompts until the installation has completed. 

If you do not already have the .NET Framework 2.0 installed, the installer will install it. This may take 

some time. 

Once the installation has completed, you should be able to see an icon for the deSide Client on your 

desktop. 

 

  

http://www.deside.info/
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Configuration 

Double-click on the deSide Client shortcut on the desktop to begin configuration. 

Proxy Setup 

The deSide Client requires access to the following websites using HTTP and XML over HTTP (SOAP): 

 www.global-roam.com 

 global-roam.webcentral.com.au 

On first startup, the deSide Client will display the proxy settings screen. This screen looks like this: 

 

The Proxy Settings screen is also available from inside the application at [Tools -> Internet Settings]. 

If you do not use a proxy to access the internet, simply click OK. 

If you do use a proxy, then we suggest that you maintain your proxy information in your system 

settings. If you make sure the [Use System Settings] option is checked on the Proxy Settings screen, 

then your system settings should automatically be detected and used in the deSide Client. 

If you have difficulties with the deSide Client with regards to internet access, you may need to 

manually specify your proxy settings and credentials. This can be done on the Proxy Settings screen. 

  

http://www.global-roam.com/
http://global-roam.webcentral.com.au/
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License Activation  

On first startup, the deSide Client will display a screen saying that “This machine does not have a 

license for deSide”. 

Simply follow the instructions on the screen to configure a license for the deSide Client (it mostly 

involves entering information/selecting options and clicking next). 

If you are trialing, on Step 3 of the licensing process (Select License), you can choose Option 2 

(Request and Activate a new Trial), which will get you a brand new trial license. 

If you do not have any licenses to select on Step 3, and you should have a full commercial license, 

then you will need to go to http://www.global-roam.com/secure to manage your licenses before you 

can go any further. After you login to the Secure website, click on My Licenses (top-right corner). On 

this page you can manage your licenses. If you didn’t have a license available in Step 3, you may 

need to deactivate one of your existing licenses to free it up for use. 

You cannot start the deSide Client without a valid license. 

Database Setup 

By default the deSide Client will attempt to connect to the global-roam web database.  You should 

only use this database for trial purposes or as a failover for your local database.   To connect to the 

global-roam web database, you will need internet access to the URL webdb.deside.info over port 

1433. 

If you will be using a database on your local network, then you should already have an SQL Server 

instance available, with the deSide Database installed on it. You will need access credentials to the 

deSide Database (read-only is acceptable, as deSide does not need to write data into the deSide 

Database). 

You will also need access credentials to the SQL Server instance with write/create permissions, to 

install the deSide Settings database. 

In this section we establish connectivity from the deSide Client to the appropriate database. 

QUESTION: Are you trialing the software? 

If “Yes” then go to Database Setup for the Trial Version on page 28 

If “No” then go to Database Setup For a Licensed Version on page 29 

  

http://www.global-roam.com/secure
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Database Setup for the Trial Version 

QUESTION: Can you start the deSide Client up normally, and does it display data? 

If “Yes”, you have managed to connect to the global-roam web database and you can go to the 

section Installing the NEM Ticker on page 38. 

If “No” (the deSide Client did not start up normally), then you have not been able to connect to the 

global-roam web database and you will see a database settings screen. 

If deSide was unable to connect to the global-roam web database, then the most likely cause 

is that you have the required URL and/or port blocked in your firewall.   

To access this web database, the deSide Client requires access to the URL webdb.deside.info 

over port 1433. 

Open this address on your firewall and restart the deSide Client (the deSide Client may be 

stuck on a database settings screen, and you will need to use the Windows Task Manager to 

kill the deSide Client application before you restart it). 

If you are successful in connecting to the global-roam web database then you can now go to the 

section Installing the NEM Ticker on page 38. 

If you are unable to connect to the global-roam web database, please contact global-roam (see 

Contacting Global-Roam on page 8). 
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Database Setup For a Licensed Version 

QUESTION: Can you start the deSide Client up normally, and did it start displaying data? 

If “Yes”, you have managed to connect to the global-roam web database.   

The deSide Client will be displaying a large title bar that says “You are currently using a 

backup database provided by Global-Roam. Please check your database settings”. You 

should click the title bar. This will display the database settings screen.  You can now go to 

the section Configuring your Database Connection on page 30 to complete the configuration 

through this screen. 

If “No”, you will need to configure database settings to connect to your local database.  

The deSide Client will be displaying the database settings screen.  You can go to the section 

Configuring your Database Connection on page 30 to complete the configuration through 

this screen. 
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Configuring your Database Connection 

You should see a screen that looks similar to the following: 

 

Note that the AEMO Database Connection on this screen will be either: 

 Red, indicating it is in error. Errors must be dealt with before you can continue (either by 

fixing them, or specifically marking the connection as ignored). 

 Yellow, indicating that it is incomplete, and only contains the backup connection provided 

by us (connecting to the global-roam web database). Using the backup connection by itself 

for a full commercial license is not recommended. 

The deSide Settings Database Connection will appear grey by default, indicating that it is ignored. 

The following instructions assume that you already have a deSide database (installed/created during 

the installation and configuration of the deSide Updater), but do not have a deSide Settings 

database. If you do have a deSide Settings database, skip the part that deals with how to install it. 

Note:  

If you have previously exported your database settings, you can import them by clicking on the 

Import Settings From File button. Importing settings is a much quicker way of configuring the 

database settings, especially if you are dealing with multiple installations of the deSide Client. 

Read on to the next section. 

  



31 
 

 

Configuring the AEMO Database Connection 

Configuring the AEMO Database Connection is NOT optional. 

This database is where the deSide Client obtains all of the data that it displays. 

To configure the AEMO Database Connection, on the database settings screen, select the AEMO 

Database Connection, and click the Configure Selected button. 

You will see: 

 

On this screen click the New button. This will create a new connection for the deSide Client to use. 
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You will see: 

 

Fill this screen in with information about how to connect to the SQL Server with the deSide Database 

on it. Test the connection to make sure that it works, and when it does, click OK. 

You will see: 

 

Your new connection has been added into the list of available connections used by the deSide Client. 

It should appear above the connection named “Online Database”. 
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You can freely add additional connections if you have access to other deSide Databases (for 

example, if you have more than 1 deSide Updater, you’ll probably want to add a connection to each 

deSide Database you have). 

The deSide Client will use the connections in the order that they appear here (i.e. if the first 

connection becomes unavailable or out-of-date, then the second connection will be used. If the first 

connection returns to a good state, it will be used). This is to allow for redundancy. The Online 

Database connection should always be the last in the list. 
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Configuring the deSide Settings Database Connection 

The deSide Settings Database Connection is optional, but it is recommended that you set one up. 

This database is where all of the user configurable settings for the deSide Client are stored (price 

thresholds, graph settings, price scales etc). If you want all of your copies of the deSide Client across 

your entire organization to share the same settings, you will need to setup one of these databases. 

To configure the deSide Settings Database Connection, on the database settings screen: 

Select the deSide Settings Database Connection, and click the Unignore Selected button. 

Follow the instructions on the screen (Click Yes). Click Configure Selected. 

On the next screen, select deSide_Settings_MSSQL from the drop-down box at the top, then 

click the New button. This will create a new connection for the deSide Client to use for its 

settings. 

Fill the next screen in with information about how to connect to an SQL Server where you 

want to install the deSide Settings Database. 

 

Note: 

 If you cannot find your SQL Server in the drop down box, you can simply type in the name of the 

machine that it is on, followed by a “\” character, followed by the instance name. e.g. 

MACHINE_NAME\INSTANCE_NAME. 

Note:  

If you have previously installed a deSide Settings database, simply select it in the drop down, click 

Test Connection, then click OK. You don’t have to install it again.  
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Once you have filled out the name, server and authentication section, use the ”Database on Server” 

drop down box to select the “<Install New Database>” option. 

Click on the “Install Database” button. 

Enter the name for the deSide Settings Database. If the default name is fine, simply click OK. 

Enter the confirmation word at the bottom of the next screen and click “Confirm” to execute the 

installation script. If you wish to check the script, or run it in some other way, feel free to extract it 

from the text box (or save it using the Save button). 

Once the script has finished executing, the database you just installed will be selected in the 

“Database on Server” drop down box. Click Test Connection to verify that everything is okay. If it is, 

click OK. 

Your new connection will be added into the list of available connections for the deSide Client to use. 

Click OK. 
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Both of your database connections (AEMO Database Connection and deSide Settings Database 

Connection) should now be green, with a status of Valid. If not, you will need to investigate why 

(likely involving reconfiguring the connections, like in the instructions above). 

 

Note:  

At this point, when all your databases are configured to be Valid, you may want to export the 

settings to file, so you can easily import them again later. This can save you time, and reduce the 

likelihood of errors while entering connections manually. Very handy if you plan on installing the 

deSide Client on another machine or machines.  

Simply click on the Export Settings To File button to do this, and save the settings in some easily 

accessible place. 

Exit the database connection screen, saving your changes. 
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Done with the deSide Client 

You’re done with the deSide Client. 

It should look something like this: 
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Installing the NEM Ticker 
You’re about to install the component highlighted in green in the following diagram. 

 

You should have an SQL Server instance available, with the deSide Database installed on it. You will 

need access credentials to the deSide Database (read-only is acceptable, as the NEM Ticker does not 

need to write data into the deSide Database). 
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Installation 

Download the install file for the NEM Ticker from the download section of the deSide web site (go to 

http://www.deside.info  and follow the links to the Download page). 

If you are using Windows XP or below, simply double click the install file, and then follow the 

prompts until it has completed.  

If you are using Windows Vista or above, right-click the install file and choose the “Run As 

Administrator” option, then follow the prompts until the installation has completed. 

If you do not already have the .NET Framework 2.0 installed, the installer will install it. This may take 

some time. 

Once the installation has completed, you should be able to see an icon for the NEM Ticker on your 

desktop. 

Configuration 

Double-click on the NEM Ticker shortcut on the desktop. 

Proxy Setup 

Since you have already setup the deSide Client, the NEM Ticker requires no additional proxy setup (it 

piggybacks off the deSide Client settings). 

License Activation 

On first startup, the NEM Ticker will display a screen saying that “This machine does not have a 

license for NEMTicker”. 

Simply follow the instructions on the screen to configure a license for the NEM Ticker (it mostly 

involves entering information/selecting options and clicking next). 

If you are trialing, on Step 3 of the licensing process (Select License), you can choose Option 2 

(Request and Activate a new Trial), which will get you a brand new trial license. 

If you do not have any licenses to select on Step 3, and you should have a full commercial license, 

then you will need to go to http://www.global-roam.com/secure to manage your licenses before you 

can go any further. After you login to the Secure website, click on My Licenses (top-right corner). On 

this page you can manage your licenses. If you didn’t have a license available in Step 3, you may 

need to deactivate one of your existing licenses to free it up for use. 

You cannot start the NEM Ticker without a valid license. 

  

http://www.deside.info/
http://www.global-roam.com/secure
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Database Setup 

By default the NEM Ticker attempts to access 2 database connections. In priority order they are: 

 webdb.deside.info:1433 

 www.dataserver3.com:1433 

If your internet security does not allow access to those URLs over those ports, then the NEM Ticker 

will display a database settings screen as soon as you start it up. Note that the InfoServer Connection 

will be red, indicating it is in error. Errors must be dealt with before you can continue (either by 

fixing them, or specifically marking the connection as ignored). 

If your internet security does allow access to those URLs over those ports, then you will simply see 

the NEM Ticker interface. Right click on the empty area above the “Top?” button and select the 

Database Options. This will display the database settings screen. 
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Configuring the InfoServer Connection 

The default configuration for this connection accesses data over the internet. If you have a local 

deSide Database, it’s sensible to set this up as the primary connection. This will increase the 

responsiveness of the NEM Ticker, and won’t waste internet bandwidth. 

To configure the InfoServer Connection, on the database settings screen: 

 

Select the InfoServer Connection, and click the Configure Selected button. 
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On the next screen click the New button. This will create a new connection for the NEM Ticker to 

use. 

 

Fill the next screen in with information about how to connect to the SQL Server with the deSide 

Database on it. Test the connection to make sure that it works, and when it does, click OK. 

 

Your new connection will be added into the list of available connections for the NEM Ticker to use. It 

should appear above the connections webdb.deside.info and www.dataserver3.com. 
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You can freely add additional connections if you have access to other deSide Databases (for 

example, if you have more than 1 deSide Updater, you’ll probably want to add a connection to each 

deSide Database you have). 

The NEM Ticker will use the connections in the order that they appear here (i.e. if the first 

connection becomes unavailable or out-of-date, then the second connection will be used. If the first 

connection returns to a good state, it will be used). This is to allow for redundancy. The two 

connections webdb.deside.info and www.dataserver3.com should always be the last in the list. 

Done with the NEM Ticker 

You’re done with the NEM Ticker. 

It should look something like this: 
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Done Installing for the First Time 
If you got to this point, then everything probably went well, and you’re all set up. Awesome! 

You’re pretty much done. You can repeat from the section Installing the deSide Client  if you need to 

install the desktop applications (deSide Client and NEM Ticker) on additional machines. 

You could repeat from the section Installing the deSide Updater  if you want to install an additional 

updater (for redundancy). You can then go add that database connection to each of the clients as an 

extra backup. 
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Upgrading an Existing Installation 
This section describes the steps for upgrading an existing installation of deSide.  These instructions 

apply only to licensed versions of the software – not to trial versions.  Where a database upgrade is 

required you will need to re-download historical data from the global-roam servers, and these 

instructions include steps to address this. 

Question: 

Do you have a version of SQL Server that is no longer supported by the deSide Suite? Any version not 

on the list of Supported Platforms on page 7 needs to be upgraded.  

If you have a non-supported version of SQL Server AND the SQL Server is not being used for anything 

else, go to the section Upgrading from an Unsupported Database on page 46. 

If you have a non-supported version of SQL Server that is being used for something else and you 

don’t want to remove it, go straight to the section Installing SQL Server on page 47. 

If you have a supported version of SQL Server, go straight to the section Upgrading from a Supported 

deSide Database on page 57.  
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Upgrading from an Unsupported Database 

Removing Old Versions of SQL Server 

Go to Add/Remove Programs and uninstall any of the unacceptable versions of Microsoft SQL 

Server. 

Navigate to C:\Program Files\Microsoft SQL Server\ and delete its contents. 

This will remove all deSide historical data, which can be replaced (if necessary) by contacting global-

roam. 

Go to the next section - Installing SQL Server. 
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Installing SQL Server 

You’re about to install the component highlighted in green in the following diagram. 

 

We recommend that you install SQL Server 2008 R2 Express. SQL Server 2008 R2 Express is a free 

database server provided by Microsoft.  

Download SQL Server 2008 R2 Express from http://www.microsoft.com/express/Database/.  

Make sure you download version appropriate for your operating system (32 bit for 32 bit operating 

systems, 62 bit for 64 bit operating systems). 

Also, make sure that you download both the database and the management tools. 

Run the installer for SQL Server Express.  You may be prompted to install .NET Framework v3.5 as a 

prerequisite. 

 These instructions assume you use the default name for the database instance which is 

“SQLEXPRESS”. 

 During the install of SQL Server Express, you will be prompted an authentication mode.  We 

recommend that you select "SQL Authentication Mode".  You will also be prompted to create an 

account for connecting to the database. We recommend that you create an account specifically 

for deSide to access the database.  This account must have read/write access to the database.   

Run the installer for the SQL Server Management Tools. 

Having run the installers, run the "SQL Server Configuration Manager" to check that the install 

worked. You can find the SQL Server Configuration Manager through the Windows Start menu under 

[Programs - Microsoft SQL Server 2008 R2 - Configuration Tools]. 

http://www.microsoft.com/express/Database/
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Use the SQL Server Configuration Manager to make the SQL Server instance accessible over the 

network. To do this, select [SQL Server Network Configuration -> Protocols for SQLEXPRESS] from the 

panel on the left hand side of the screen, and enable at least TCP/IP.  

Note:  

To make the SQL Server instance accessible over your network you may also need to open up TCP 

ports appropriately on the host machines firewall. The default SQL Server port is 1433. 
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Deleting the State of the deSide Updater 

The state of the deSide Updater is how it remembers what files it has downloaded, validated and 

processed, from the global-roam dataservers. 

We’re installing a brand new database, so we don’t want to keep any of the old state information. 

To clear the deSide state information on Windows XP or below: 

 Navigate to “C:\Documents and Settings\All Users\Application Data\global-roam\deSideV2 

Data Updater\”  

 Delete everything from that directory EXCEPT the file “deSideV2 Data Updater.grlic” (that’s 

your license, don’t delete that). 

To clear the deSide state information on Windows Vista or above: 

 Navigate to “C:\ProgramData\global-roam\deSideV2 Data Updater\”  

 Delete everything from that directory EXCEPT the file “deSideV2 Data Updater.grlic” (that’s 

your license, don’t delete that). 

 

You can now go to the next section - Upgrading the deSide Updater (with a blank database)  on page 
50. 
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Upgrading the deSide Updater (with a blank database) 

You’re about to upgrade the component highlighted in green in the following diagram. 

 

The deSide Updater connects to the SQL Server and so you will need to have the details for this 

connection. These details are: 

 The address for this SQL Server instance (machine name and SQL server instance name). 

 The account details for connection to the database.  Make sure you have an account with 

write permissions, because you will be using the deSide Updater to create the necessary 

database and tables. The deSide Updater also requires write permissions to the database in 

general, as it will be constantly writing to the database as part of its normal operation. 

The deSide Updater should be installed on a stable machine, one with high availability (on all the 

time, does not regularly get restarted). Desktops and laptops are not usually acceptable for the 

deSide Updater (there’s nothing stopping you from installing the deSide Updater on them, but do it 

at your own peril).  
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Installation  

Download the install file for the deSide Updater from the download section of the deSide web site 

(go to http://www.deside.info  and follow the links to the Download page). 

If you are using Windows XP or below, simply double click the install file, and then follow the 

prompts until it has completed.  

If you are using Windows Vista or above, right-click the install file and choose the “Run As 

Administrator” option, then follow the prompts until the installation has completed. 

If you do not already have the .NET Framework 4.0 installed, the installer will install it. This may take 

some time. 

Once the installation has completed, you should be able to see an icon for the deSide Updater on 

your desktop. Additionally, there will be Windows Service installed called “deSide UpdateEngine”. 

The Windows Service will be installed with default login details. Following the install, confirm that 

these logon details are set to a user who has access to the internet and to the SQL Server instance 

that you have chosen (the deSide Updater requires access to the internet and to its database).  

http://www.deside.info/
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Configuration  

Double-click on the deSide Update Service shortcut on the desktop. This is the deSide Updater 

interface when it’s not doing anything: 

 

Go to File -> Application -> Start. 
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Database Setup 

On first startup, the deSide Updater may display a screen called “Data Source Setup”. If it does not, 

then it has loaded your previous database settings. If this is the case, skip forward to Done with the 

deSide Updater on page 56. 

This screen is the database settings screen. It will allow you to point the deSide Updater at the 

database that it needs to update. On first startup, it will look something like this: 

 

Configuring the AEMO Database Connection 

This database is where the deSide Updater stores all of the data that it downloads. To configure the 

AEMO Database Connection, from the database settings screen 

 Select the AEMO Database Connection 

 Click the Configure Selected button. 

On the next screen, select AEMO_MSSQL in the drop-down box at the top, and click the New button. 
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Fill the next screen in with information about how to connect to an SQL Server where you want to 

install the deSide Database.  

 

Note: If you cannot find your SQL Server in the server drop down box, you can simply type in the 

name of the machine that it is on, followed by a “\” character, followed by the instance name. e.g. 

MACHINE_NAME\INSTANCE_NAME. 

Once you have filled out the name, server and authentication, use the ”Database on Server” drop 

down box to select the “<Install New Database>” option.  

Click on the “Install Database” button. 

Enter the name for the deSide Database. If the default name is fine, simply click OK. If you enter 

something different write it down for later. 
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Enter the confirmation word at the bottom of the next screen and click “Confirm” to execute the 

installation script. If you wish to check the script, or run it in some other way, feel free to extract it 

from the text box (or save it using the Save button). 

Once the script has finished executing, the database you just installed will be selected in the 

“Database on Server” drop down box. Click Test Connection to verify that everything is okay. If it is, 

click OK. 

Keep clicking OK until you get back to the main database settings screen. It should now look like this: 

 

Note that the AEMO Database Connection says “Valid” next to it (this means it’s all set up and ready 

to go). 

Click Done. 

Note:  

If you need to change your database settings after setting them up initially, stop the deSide Updater, 

go to “C:\Documents and Settings\All Users\Application Data\global-roam\deSide Data Updater\” 

(on Windows Vista and above, C:\ProgramData\global-roam\deSide Data Updater\”) and delete the 

file “deSideDataUpdater_DataAccessManager.settings.xml”. Restart the deSide Updater in 

application mode (File -> Application -> Start) and it will prompt you for database settings again. 
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Done with the deSide Updater 

At this point your updater should be showing a list of file types, and the last times that a file of that 

type was downloaded and processed. 

Please leave the deSide Updater to run until it has finished populating the database for the first 

time. This may take an hour or so, depending on the speed of your machine.  

Once the population has run for about an hour, you can safely go to File -> Application -> Stop, and 

then go to File -> Service -> Start in order to set the deSide Updater to run completely 

autonomously. You can safely close the Updater Interface at this point, and it will continue to work 

in the background as a Windows Service. 

If you cannot see at least some activity, or if you do not have any files appearing at all, or you see red 

errors, something is wrong, and the deSide Updater is probably not working. If this is the case, 

please contact global-roam. 

Go to the section Installing the Database Maintenance Scripts (the Reaper on page 66.  
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Upgrading from a Supported deSide Database 
You’re about to upgrade the component highlighted in green in the following diagram. 

 

Since you supported version of SQL Server, but an old version of the deSide Database, you will need 

to upgrade it to the latest version. 

All of the upgrade scripts are stored in a file called Database_Scripts.zip that you can download from 

the downloads section of the deSide website (go to http://www.deside.info/ and follow the links to 

the Download page). 

Go to Upgrading the NEMMCO/AEMO Tables, on page 58.  

http://www.deside.info/
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Upgrading the NEMMCO/AEMO Tables 

The structure of the tables relating to the NEMMCO/AEMO data has changed since the last time 

deSide was released. 

Navigate to the directory where you extracted the Database_Scripts.zip file, navigate to the 

NEMMCO directory, and then navigate to the MSSQL directory. 

Run all scripts labeled with a version greater than the highest version found in your 

NEMMCO_Version table (if you do not have a NEMMCO_Version table, assume the version is 1), in 

order of smallest to largest. 

To clarify, if there are 6 scripts in the directory, labeled 2, 3, 4, 5, 6, 7, and your local 

database version is 3, then you should run the scripts 4, 5, 6 and 7 in that order on your 

database. 

You can run scripts through whatever interface to your database you have available, but we suggest 

using Microsoft SQL Server Management Studio for MSSQL Server, and SQL Developer for Oracle. 

Note ɀ SQL Management Tools 

If you do not have any tools for managing your SQL Server, then you can download and install 

Microsoft SQL Server Management Studio from the Microsoft website (you’re looking for the 

installer for SQL Server 2008 R2 Express Edition, it will allow you to install the Management Tools by 

themselves). 

Go to Upgrading the deSide Updater (with an upgraded database), on page 59. 
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Upgrading the deSide Updater (with an upgraded database) 

You’re about to upgrade the component highlighted in green in the following diagram. 

 

The deSide Updater connects to the SQL Server and so you will need to have the details for this 

connection. These details are: 

 The address for this SQL Server instance (machine name and SQL server instance name). 

 The account details for connection to the database.  Make sure you have an account with 

write permissions, because you will be using the deSide Updater to create the necessary 

database and tables. The deSide Updater also requires write permissions to the database in 

general, as it will be constantly writing to the database as part of its normal operation. 

The deSide Updater should be installed on a stable machine, one with high availability (on all the 

time, does not regularly get restarted). Desktops and laptops are not usually acceptable for the 

deSide Updater (there’s nothing stopping you from installing the deSide Updater on them, but do it 

at your own peril). 
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Installation  

Download the install file for the deSide Updater from the download section of the deSide web site 

(go to http://www.deside.info  and follow the links to the Download page). 

If you are using Windows XP or below, simply double click the install file, and then follow the 

prompts until it has completed.  

If you are using Windows Vista or above, right-click the install file and choose the “Run As 

Administrator” option, then follow the prompts until the installation has completed. 

If you do not already have the .NET Framework 4.0 installed, the installer will install it. This may take 

some time. 

Once the installation has completed, you should be able to see an icon for the deSide Updater on 

your desktop. Additionally, there will be Windows Service installed called “deSide UpdateEngine”. 

The Windows Service will be installed with default login details. Following the install, confirm that 

these logon details are set to a user who has access to the internet and to the SQL Server instance 

that you have chosen (the deSide Updater requires access to the internet and to its database). 

  

http://www.deside.info/
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Configuration  

Double-click on the deSide Update Service shortcut on the desktop. This is the deSide Updater 

interface when it’s not doing anything: 

 

Go to File -> Application -> Start. 

  



62 
 

 

Database Setup 

On first startup, the deSide Updater may display a screen called “Data Source Setup”. If it does not, 

then it has loaded your previous database settings. If this is the case, skip forward to Done with the 

deSide Updater. 

This screen is the database settings screen. It will allow you to point the deSide Updater at the 

database that it needs to update. On first startup, it will look something like this: 

 

Configuring the AEMO Database Connection 

This database is where the deSide Updater stores all of the data that it downloads. To configure the 

AEMO Database Connection, from the database settings screen 

 Select the AEMO Database Connection 

 Click the Configure Selected button. 

On the next screen, select AEMO_MSSQL in the drop-down box at the top, and click the New button. 
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Fill the next screen in with information about how to connect to the SQL Server with the deSide 

Database on it. Test the connection to make sure that it works, and when it does, click OK. 

 

Note:  

If you cannot find your SQL Server in the server drop down box, you can simply type in the name of 

the machine that it is on, followed by a “\” character, followed by the instance name. e.g. 

MACHINE_NAME\INSTANCE_NAME. 

Keep clicking OK until you get back to the main database settings screen. It should now look like this: 
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Note that the AEMO Database Connection says “Valid” next to it (this means it’s all set up and ready 

to go). 

Click Done. 

Note:  

If you need to change your database settings after setting them up initially, stop the deSide Updater, 

go to “C:\Documents and Settings\All Users\Application Data\global-roam\deSideV2 Data Updater\” 

(on Windows Vista and above, C:\ProgramData\global-roam\deSideV2 Data Updater\”) and delete 

the file “deSideV2DataUpdater_DataAccessManager.settings.xml”. Restart the deSide Updater in 

application mode (File -> Application -> Start) and it will prompt you for database settings again. 
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Done with the deSide Updater 

At this point your updater should be showing a list of file types, and the last times that a file of that 

type was downloaded and processed. 

After a few minutes, you can safely go to File -> Application -> Stop, and then go to File -> Service -> 

Start in order to set the deSide Updater to run completely autonomously. You can safely close the 

Updater Interface at this point, and it will continue to work in the background as a Windows Service. 

If you cannot see at least some activity, or if you do not have any files appearing at all, or you see red 

errors, something is wrong, and the deSide Updater is probably not working. If this is the case, 

please contact global-roam. 

Go to the section Installing the Database Maintenance Scripts (the Reaper Script) on page 66. 

  



66 
 

 

Installing the Database Maintenance Scripts (the Reaper Script) 
The reaper is a small SQL Script set to run automatically at regular intervals, to keep the size of the 

deSide Database relatively small. This section provides instructions for setting up a Windows 

Scheduled task to run this Reaper Script at regular intervals. You will need to download the script 

and place it in a well known folder that is accessible to the Scheduled Task. 

Download the Reaper Script for the deSide Updater from the download section of the deSide web 

site (go to http://www.deside.info  and follow the links to the Download page). 

Set up a new Windows Scheduled Task – if you need to, please consult the Windows Help system to 

find out how to establish a Scheduled Task on your operating system. 

The Scheduled Task should be set up to run a command line as follows: 

sqlcmd.exe -S [SERVER_NAME] -U [USERNAME] -P [PASSWORD] -i [PATH TO SCRIPT] 

where the following are the arguments: 

 SERVER_NAME is the fully qualified address of the SQL Server that the deSide Database is 

installed on (MACHINENAME\INSTANCENAME) 

 

 USERNAME is a user account in the specified SQL Server with delete permissions on the deSide 

Database 

 

 PASSWORD is the SQL Server password for the above USERNAME 

 

 PATH_TO_SCRIPT is the full path to the Reaper script file that you downloaded above 

Note that sqlcmd.exe is typically located in  

C:\Program Files\Microsoft SQL Server\[VERSION]\Tools\Binn. 

Pick the latest version if there are multiple. 

Schedule this task to occur every day (once every 24 hours) at midnight. 

Note: 

The Reaper Script relies on the fact that the database name is correct in the script. By default this 

name is “NEMMCO”, but it may be different if: 

 You chose a different name for the database when you installed it while configuring the 

deSide Updater above. 

 You upgraded an existing deSide Database to the latest version. 

If your deSide database is NOT named “NEMMCO” you will need to slightly change the downloaded 

script file.  

The section you need to modify is at the top of the file. It looks like this: 

http://www.deside.info/
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USE NEMMCO 

GO 

Change the word “NEMMCO” to *YOUR_DATABASE_NAME+ (make sure you include the square 

braces), and save the script.  
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Upgrading the deSide Client 
You’re about to upgrade the component highlighted in green in the following diagram. 

 

You should have an SQL Server instance available, with the deSide Database installed on it. You will 

need access credentials to the deSide Database (read-only is acceptable, as deSide does not need to 

write data into the deSide Database). 

You will also need access credentials to the SQL Server instance with write/create permissions, to 

install the deSide Settings database. 
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Installation 

Download the deSide Client from the download section of the deSide web site (go to 

http://www.deside.info  and follow the links to the Download page).  

If you are using Windows XP or below, simply double click the install file, and then follow the 

prompts until it has completed.  

If you are using Windows Vista or above, right-click the install file and choose the “Run As 

Administrator” option, then follow the prompts until the installation has completed. 

If you do not already have the .NET Framework 2.0 installed, the installer will install it. This may take 

quite a while. 

Once the installation has completed, you should be able to see an icon for the deSide Client on your 

desktop. 

 

  

http://www.deside.info/
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Configuration 

Double-click on the deSide Client shortcut on the desktop to begin configuration. 

Database Setup 

By default the deSide Client will attempt to connect to the global-roam web database.  You should 

only use this database for trial purposes or as a failover for your local database. In this section we 

establish connectivity from the deSide Client to your local database. 

Question: 

Did the deSide Client start up normally, and start displaying data? 

If “Yes”, click on the large title bar that says “You are currently using a backup database provided by 

Global-Roam. Please check your database settings”. This will display the database settings screen. 

If “No” (the deSide Client did not start up normally), then you will see a database settings screen as 

soon as you start it up. The database settings screen will look similar to the following: 

 

Note that the AEMO Database Connection on this screen will be either: 

 Red, indicating it is in error. Errors must be dealt with before you can continue (either by 

fixing them, or specifically marking the connection as ignored). 

 Yellow, indicating that it is incomplete, and only contains the backup connection provided 

by us. 

The deSide Settings Database Connection will appear grey by default, indicating that it is ignored. 
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The following instructions assume that you already have a deSide database (installed/created during 

the installation and configuration of the deSide Updater), but do not have a deSide Settings 

database. If you do have a deSide Settings database, skip the part that deals with how to install it. 

Note: If you have previously exported your database settings, you can import them by clicking on the 

Import Settings From File button. Importing settings is a much quicker way of configuring the 

database settings, especially if you are dealing with multiple installations of the deSide Client. 

Read on to the next section. 
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Configuring the AEMO Database Connection 

Configuring the AEMO Database Connection is NOT optional. 

This database is where the deSide Client obtains all of the data that it displays. 

To configure the AEMO Database Connection, on the database settings screen, select the AEMO 

Database Connection, and click the Configure Selected button. 

You will see: 

 

On this screen click the New button. This will create a new connection for the deSide Client to use. 
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You will see: 

 

Fill this screen in with information about how to connect to the SQL Server with the deSide Database 

on it. Test the connection to make sure that it works, and when it does, click OK. 

You will see: 

 

Your new connection has been added into the list of available connections used by the deSide Client. 

It should appear above the connection named “Online Database”. 
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You can freely add additional connections if you have access to other deSide Databases (for 

example, if you have more than 1 deSide Updater, you’ll probably want to add a connection to each 

deSide Database you have). 

The deSide Client will use the connections in the order that they appear here (i.e. if the first 

connection becomes unavailable or out-of-date, then the second connection will be used. If the first 

connection returns to a good state, it will be used). This is to allow for redundancy. The Online 

Database connection should always be the last in the list. 
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Configuring the deSide Settings Database Connection 

The deSide Settings Database Connection is optional, but it is recommended that you set one up. 

This database is where all of the user configurable settings for the deSide Client are stored (price 

thresholds, graph settings, price scales etc). If you want all of your copies of the deSide Client across 

your entire organization to share the same settings, you will need to setup one of these databases. 

To configure the deSide Settings Database Connection, on the database settings screen: 

Select the deSide Settings Database Connection, and click the Unignore Selected button. Follow the 

instructions on the screen (Click Yes). Click Configure Selected. 

On the next screen, select deSide_Settings_MSSQL from the drop-down box at the top, then click 

the New button. This will create a new connection for the deSide Client to use for its settings. 

Fill the next screen in with information about how to connect to an SQL Server where you want to 

install the deSide Settings Database. 

 

Note:  

If you cannot find your SQL Server in the drop down box, you can simply type in the name of the 

machine that it is on, followed by a “\” character, followed by the instance name. e.g. 

MACHINE_NAME\INSTANCE_NAME. 

Note:  

If you have previously installed a deSide Settings database, simply select it in the drop down, click 

Test Connection, then click OK. You don’t have to install it again.  
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Once you have filled out the name, server and authentication section, use the ”Database on Server” 

drop down box to select the “<Install New Database>” option. 

Click on the “Install Database” button. 

Enter the name for the deSide Settings Database. If the default name is fine, simply click OK. 

Enter the confirmation word at the bottom of the next screen and click “Confirm” to execute the 

installation script. If you wish to check the script, or run it in some other way, feel free to extract it 

from the text box (or save it using the Save button). 

Once the script has finished executing, the database you just installed will be selected in the 

“Database on Server” drop down box. Click Test Connection to verify that everything is okay. If it is, 

click OK. 

Your new connection will be added into the list of available connections for the deSide Client to use. 

Click OK. 
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Both of your database connections (AEMO Database Connection and deSide Settings Database 

Connection) should now be green, with a status of Valid. If not, you will need to investigate why 

(likely involving reconfiguring the connections, like in the instructions above). 

 

Note:  

At this point, when all your databases are configured to be Valid, you may want to export the 

settings to file, so you can easily import them again later. This can save you time, and reduce the 

likelihood of errors while entering connections manually. Very handy if you plan on installing the 

deSide Client on another machine or machines.  

Simply click on the Export Settings To File button to do this, and save the settings in some easily 

accessible place. 

Exit the database connection screen, saving your changes. 
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Done with the deSide Client 

You’re done with the deSide Client. 

It should look something like this: 
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Installing the NEM Ticker 
You’re about to install the component highlighted in green in the following diagram. 

 

You should have an SQL Server instance available, with the deSide Database installed on it. You will 

need access credentials to the deSide Database (read-only is acceptable, as the NEM Ticker does not 

need to write data into the deSide Database). 
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Installation 

Download the install file for the NEM Ticker from the download section of the deSide web site (go to 

http://www.deside.info  and follow the links to the Download page). 

If you are using Windows XP or below, simply double click the install file, and then follow the 

prompts until it has completed.  

If you are using Windows Vista or above, right-click the install file and choose the “Run As 

Administrator” option, then follow the prompts until the installation has completed. 

If you do not already have the .NET Framework 2.0 installed, the installer will install it. This may take 

some time. 

Once the installation has completed, you should be able to see an icon for the NEM Ticker on your 

desktop. 

  

http://www.deside.info/
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Configuration 

Double-click on the NEM Ticker shortcut on the desktop. 

Proxy Setup 

Since you have already setup the deSide Client, the NEM Ticker requires no additional proxy setup (it 

piggybacks off the deSide Client settings). 

License Activation 

On first startup, the NEM Ticker may display a screen saying that “This machine does not have a 

license for NEMTicker”. 

Simply follow the instructions on the screen to configure a license for the NEM Ticker (it mostly 

involves entering information/selecting options and clicking next). 

If you do not have any licenses to select on Step 3, and you should have a full commercial license, 

then you will need to go to http://www.global-roam.com/secure to manage your licenses before you 

can go any further. After you login to the Secure website, click on My Licenses (top-right corner). On 

this page you can manage your licenses. If you didn’t have a license available in Step 3, you may 

need to deactivate one of your existing licenses to free it up for use. 

You cannot start the NEM Ticker without a valid license. 

  

http://www.global-roam.com/secure
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Database Setup 

By default the NEM Ticker attempts to access 2 database connections. In priority order they are: 

 webdb.deside.info:1433 

 www.dataserver3.com:1433 

If your internet security does not allow access to those URLs over those ports, then the NEM Ticker 

will display a database settings screen as soon as you start it up. Note that the InfoServer Connection 

will be red, indicating it is in error. Errors must be dealt with before you can continue (either by 

fixing them, or specifically marking the connection as ignored). 

If your internet security does allow access to those URLs over those ports, then you will simply see 

the NEM Ticker interface. Right click on the empty area above the “Top?” button and select the 

Database Options. This will display the database settings screen. 
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Configuring the InfoServer Connection 

The default configuration for this connection accesses data over the internet. If you have a local 

deSide Database, it’s sensible to set this up as the primary connection. This will increase the 

responsiveness of the NEM Ticker, and won’t waste internet bandwidth. 

To configure the InfoServer Connection, on the database settings screen: 

 

Select the InfoServer Connection, and click the Configure Selected button. 

 

  



84 
 

 

On the next screen click the New button. This will create a new connection for the NEM Ticker to 

use. 

 

Fill the next screen in with information about how to connect to the SQL Server with the deSide 

Database on it. Test the connection to make sure that it works, and when it does, click OK. 

 

Your new connection will be added into the list of available connections for the NEM Ticker to use. It 

should appear above the connections webdb.deside.info and www.dataserver3.com. 
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You can freely add additional connections if you have access to other deSide Databases (for 

example, if you have more than 1 deSide Updater, you’ll probably want to add a connection to each 

deSide Database you have). 

The NEM Ticker will use the connections in the order that they appear here (i.e. if the first 

connection becomes unavailable or out-of-date, then the second connection will be used. If the first 

connection returns to a good state, it will be used). This is to allow for redundancy. The two 

connections webdb.deside.info and www.dataserver3.com should always be the last in the list. 

Done with the NEM Ticker 

You’re done with the NEM Ticker. 

It should look something like this: 
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